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An Introduction to the Web
The World Wide Web, often abbreviated as WWW, is the fastest and easiest way to access the resources 
of the Internet. The number of individuals, companies, organizations, and even governments that can be 
found on the Web is growing daily and the PRODIGY Web Browser makes surfing EASY by pointing you 
to intriguing Hot Spots. 

The PRODIGY Web Browser also makes it easy for you to click on hyperlinks and navigate to just about 
any destination. If you're interested in finding Web content for specific subjects that interest you, choose 
Search Tools from the PRODIGY Home Page. For updates on using the Web Browser and a listing of the 
newest features, be sure to check Browser News, also available from the PRODIGY Home Page. 

Please note that it is NOT necessary to read this help file online. In most cases, you can easily access 
this help file without being connected to the Web. To do this, start File Manager, navigate to the drive and 
directory where PRODIGY for Windows is installed and then double click on the file pweb.hlp. 



Home Pages
A home page is the "front page" of a World Wide Web site. PRODIGY's home page offers you a number 
of good starting points for exploring the WWW. Select any hyperlink from PRODIGY's home page to get 
started. For a quick look at other members favorite URL's, you may want to visit PRODIGY's Internet 
Bulletin Board, and check the Wide World Web topic.



Hyperlink Jumps
Hypertext links, or hyperlinks, are used to navigate to images, sounds, files and related information. 
Clicking on a hyperlink is the easiest way to begin exploring the WWW. Hypertext links are often 
emphasized with underlining.



Viewers
The World Wide Web is not just a place to find information and files -- browsing the Web is a multimedia 
experience, complete with colorful graphics, images to view and sounds to hear. PRODIGY's Web 
Browser includes built-in support for the most common image types, GIF and JPG, and the most common 
sound types, AU and WAV. But you're bound to come across Web content that uses other standards for 
images, video and audio.

To see and hear images and sound provided in other formats, you'll need to obtain and install accessory 
programs called viewers. A variety of viewers have been created to decode the different kinds of files you 
may encounter as you browse the Web. As experienced Web surfers have found, these external viewers 
make Web browsing richer and more entertaining.

Extensive information on viewers is available from the PRODIGY home page where you can select 
[Viewers] for comprehensive information.

Please note that Prodigy Services Company does not support or endorse these programs, nor can 
we provide assistance in their installation or configuration.

 Click for more info on setting up viewers.



 FTP, Gopher, and Web Sites
PRODIGY's Web Browser supports Wide World Web, FTP, and Gopher. 

(Telnet and IRC are not available. )

Here are examples of Web, FTP and Gopher URLs that you can try: 

Sample Wide World Web site: 

Microsoft product information and news 

http://www.microsoft.com/ 

Sample FTP site:

Microsoft FTP software library:

ftp://ftp.microsoft.com/

Sample Gopher Site:

Weather data by state 

gopher://wx.atmos.uiuc.edu/11/States 

For additional information:

See Also:
FTP (File Transfer Protocol)

Gopher

Web



FTP (File Transfer Protocol)
PRODIGY's Web Browser automatically supports anonymous FTP. The information to login to a site is 
automatically sent to the anonymous FTP server you are trying to access. All you have to do is enter the 
URL and let PRODIGY do the rest.

Non-anonymous FTP login is available through the PRODIGY Web Browser, but it is very important that 
you completely read and understand the insecure nature of attempting this before you decide to proceed:

1) The ID and password becomes part of the URL, and therefore the URL should not be disclosed to 
anyone, and 

2) You should NEVER NEVER NEVER use your PRODIGY ID and password for this.

3) Because of this, it is strongly recommended that you disable Global History before doing non-
anonymous FTP, if you expect anyone else in the household or organization to use your machine.

If you still wish to use non-anonymous FTP, here is the information on the procedure to use:

To access an FTP site that requires an ID and password, put the following information in the URL just 
after the ftp:// and just before the hostname:

id:password@

For example, if the FTP site called "ftpsite.com" required an ID of "myid" and a password of 
"mypassword", the URL would be:

ftp://myid:mypassword@ftpsite.com

This causes the PRODIGY server to establish a connection with ftpsite.com, using myid as the ID and 
mypassword as the password.

Also remember that most data on the Internet is transmitted "in the clear", including IDs and passwords, 
and accessing FTP sites through the PRODIGY Web Browser is no exception.



Gopher
Note that some Gophers limit the number of accesses from the Internet at peak hours and a few Gophers 
may contain items which you cannot access because they are protected from public view    or are links to 
services that you need to use telnet to connect to which is not support by the PRODIGY Web browser. 

There are several Veronica interfaces (an index to files found on many of the Internet's public Gopher 
servers) located on the Web. For a detailed description of how to compose Veronica queries available, 
you may wish to try:

gopher://gopher.scs.unr.edu:70/hh/veronica/About/how-to-query-veronica-html

Additional information on Gopher is available from the PRODIGY home page



Web
Using the Prodigy Web browser to access Web (more properly known as HTTP) servers is the easiest of 
all. Most of the time when you are clicking on a highlighted hyperlink on one of the pages in this 
documentation you are using a Web server. 

When you select a hyperlink that interests you the browser will automatically navigate to a new page. 
Web servers are full of fun and zany things to see and do as well as educational information, and more 
and more companies have started offering goods and services for sale via Web pages. For security 
purposes, we recommend that you do not enter any credit card number while on the Web, since 
these are likely to by insecure transaction.

Popular HTTP servers that are also great places to begin exploring the Web are EINET, NCSA, CERN, 
CUI and GNN ( URLs http://www.einet.net/ , http://www.ncsa.uiuc.edu/ , http://info.cern.ch , 
http://cuiwww.unige.ch/w3catalog , http://gnn.com ).



File Menu 

These choices appear on the File menu: 

Open Local Document

If you have previously saved (or even created) a Web page in *.htm format, you can open this local file 
stored on your hard drive and use it in the same manner as any URL you can access while using 
PRODIGY's Web Browser. In addition, you can run PRODIGY's Web Browser without being connected to 
the PRODIGY Network and use it as a viewer for Web pages you have saved. Remember that graphics 
displayed as inline images are not saved along with the text. These will be replaced by a "missing image" 
icon as a placeholder.

You can also open plain text (normally *.txt ) files and view them using Open Local Document. Select the 
drop down arrow in the List Files of Type dialog and then select All Files (*.*). 

Save As 

Opens the Windows dialog box that enables you to save the current Web page as an HTML file on your 
hard disk. It's recommended that you use an *.htm extension for any Web pages you save.

Print 

Sends the current page to the printer. If your printer can print graphics, any inline graphics that appear will 
also be printed. 

Page Setup 

Changes margin settings for printing. Page setup will always be dependent on the particular printer you 
are using. 

 Click for more info
Exit 
Closes the Web Browser so you can continue with your PRODIGY session (or closes the browser if you 
are using it offline). 



Edit Menu 
These choices appear on the Edit menu: 

Copy 

Copies the current page to your Clipboard. 



Options Menu 

The following choices on the Options Menu allow you to customize how the Web browser looks and 
operates.

Image Loading 

This menu select will display the Image Loading dialog box which lets you control the settings which 
determine if images are to be displayed and the manner in which they will be displayed on your screen. 
You will probably want to experiment with this setting as it is usually a matter of personal preference 
which method is more visually appealing. 

  Click for details on how to customize image loading.
Background Color 
Allows you to choose a different background color from the palette provided, or create your own using the 
Custom Color feature. Default background color is white. 

Text Styles

You can customize the type style used to display web pages as well as the color of text (excluding 
hypertext links which are displayed in blue). A default text scheme is provided which cannot be changed, 
but you can create as many different named text schemes alternatives as you wish.

 Click for more info on changing Text Styles
Advanced Setup
The Advanced Setup menu selections lets you specify 'viewers', customize how or if web pages are 
stored (cached) on your PC in a special 'stage' file, and change settings for prompting to save a page to 
your hard drive for viewing offline. (By default, the browser will attempt to display all pages up to 150KB in 
size. If you retrieve a page that is larger, when the page is fully downloaded, a standard windows "File 
Save As" box will be automatically displayed that gives you the option of saving the file to disk.)

You can access more information on these features by clicking on the links below.

 Click for Advanced Setup Info on Viewer Setup

 Click for Advanced Setup Info on Stage Setup

 Click for more info on Document Setup



Navigate Menu 

The following choices appear on the Navigate Menu: 

Get URL 

Opens a dialog box that lets you enter a URL and navigate to it. (URLs can also be entered directly in the 
Document URL blank by typing over or deleting the current URL, then pressing Enter.) 

Universal Resource Locators (URLs) are the "addresses" of Internet pages, files and other objects. Every 
Web page you view has a unique URL. 

Hot Lists 

Opens a dialog box that enables you to add favorite Web pages to your Hot List, or select from saved 
Web page URLs for display. Additionally, you can create multiple hotlists that can be used for different 
members using the same computer and/or hotlists by category, or just about any type of system you wish 
to design for maintaining separate hotlists!

 Click to learn more about Hot Lists 
Global History
As you navigate through pages on the Web, you can keep a global history that retains a record of URL's 
visited and the date and time of this visit. You can use the list in the Global History Window to return to a 
site you've visited previously.

 Click for more info
Home Page 
Navigates you to the PRODIGY home page, which is also the first Web page you see when you open the 
PRODIGY Web Browser. The PRODIGY service home page is the default. 
Previous Page 
Navigates to the previous Web page. 
Next Page 
Navigates to the next Web page (available only if you've already navigated back to your home page or to 
a previously-viewed page during the current session). 
Reload 
Reload: Requests that the current Web page be sent to you again. Reload comes in handy when you've 
used Stop in the middle of receiving a Web page, but then decide that you'd like to receive the entire 
page. 
Reload from Host 
Requests that the current Web page be sent again from its original host site. Because this option 
bypasses all local and server caching, select Reload From Host when you want to be sure you're seeing 
the latest version of the current page. 

Send Email

While browsing the Web, you're likely to come across many sites where additional information is available 



via Internet Email. In many cases the address will be similar to "webmaster@thissite.com". If you want to 
compose and then send an Internet Email message, select the Navigate menu and then Send Email. A 
dialog window will display where you can enter the full internet address of the party to whom you wish to 
write. You can then specify a subject if you wish and then type text in the message body area. (Note that 
you can also paste from the Windows clipboard into the body message area). 

If a Web page has a built in "mailto:" link, selecting that hyperlink will automatically display the Send Email 
dialog window.

Note: some choices may be grayed out and unavailable because they are dependent on how you 
have navigated in your current session.



Help Menu 

The following choices appear on the Help menu: 

Contents 

Contents of help topics 

Search For 

Searches help topics. Enter a key word, such as FTP or Viewer to quickly find information on a subject.

Session Status 

Provides information about your current Web Browser session, including the amount of time you've been 
using the browser. 

Document Header 

Offers information about the source, type and creation date of the current Web page. When you receive 
an error message, often viewing the Document Header can provide additional information on whether the 
site you are attempting to access is 'full' or unavailable, or other useful messages. The Document Header 
also will display information if the remote site was not contacted, indicating that the document is a copy 
stored on PRODIGY's Web servers. 

About 

Information about the Web Browser itself, including the version number and release date. 



Document Title 
All document titles for pages you've seen during the current Web session are available here. Click on the 

 button at the far right of the Document Title display field to open the list and select a page from 
among those you've already seen. 

In the sample shown, "Prodigy Home Page" is the Document Title.



Document URL 

Universal Resource Locators (URLs) are the "addresses" of Internet pages, files and other objects. Every 
Web page you view has a unique URL. The document URL in the above sample is 
http://antares.prodigy.com/welcome.htm

If you know the URL for a Web page, FTP or Gopher site, you can type it directly in the Document URL 
blank, then press Enter. Remember that you can use the Windows clipboard functions to copy an URL 
that you find posted on a PRODIGY Bulletin Board or elsewhere and then paste it into the URL field when 
browsing the Web. Place the cursor on the highlighted URL field and then press SHIFT-INSERT. The URL 
you previously placed on the clipboard will replace the highlighted text. After the URL has been pasted, 
press [Enter].

If you make a mistake when typing or specifying an URL, you may get an error message. Simply double-
check the URL you wanted to retrieve, make any needed corrections, and try again. 

You can review URLs for all the pages you've seen during the current Web session by clicking on the  
button at the far right of the Document URL display field. Select any URL to return directly to that Web 
page. 



Using theToolBar 

Stop 

Stops the current Web page, image or file from continuing to download. 

Selecting Stop can save time and speed up your Web session. Use Stop when enough of a Web page 
has displayed for you to select an available hyperlink, or if you decide that you're not interested in seeing 
more of what's currently being downloaded. 

Back 

Navigates to the previous Web page.

Forward 

Navigates to the next Web page (available only if you've already navigated back to your home page or to 
a previously-viewed page during the current session). 

Home 

Navigates you to your Web browser home page. The PRODIGY service home page is the default. 

Hot List 

Opens a dialog box that enables you to add favorite Web pages to your Hot List, or select from saved 
Web page URLs for display. 

Save 

Opens the Windows dialog box that enables you to save the current Web page as an HTML file on your 
hard disk. 

Reload 

Reload requests that the current Web page be sent to you again. 

Reload comes in handy when you've used Stop in the middle of receiving a Web page, but then decide 
that you'd like to receive the entire page. 

Load Images (checkbox)

Note the checkbox to the right of the Reload button. A single mouse click inside this box enables or 
disables image loading. You can speed up total loading time for many pages on the Web by not loading 
images. You can quickly turn image loading on or off by clicking inside this box.

Note that not all buttons may be selectable at any given time. For example, the Forward button 
does not become available until you have used the Back button. Stop is only available while a 
page is loading.



Image Loading Dialog Box

Load Images toggles the option to receive inline images (images that are incorporated into a Web page). 
Default is ON. (This function is duplicated in a selectable check box to the right of the buttons under the 
menu bar so you can see the status of Load Images at a glance, and change it "on the fly.") Turning off 
the Load Images option will speed up display of Web pages. Consider turning off Load Images to improve 
performance, especially if you're viewing graphics-intensive pages or if you're connected at less than 
14,400 bps. 

Draw Images Line by Line toggles the option to paint inline images (GIF's) incrementally as they're 
received, or all at once after they're fully received. Default is OFF. 

Fade In Incremental Images is an additional option which can be used when Draw Images Line by Line 
is selected that 'paints' the image to your screen as it is being received. Only interlaced GIF images can 
be faded in. The visual effect is similar to using a focus adjustment on a telescope; the image will first 
appears out of focus as different colors and areas are painted and when complete, the full image will 
resolve to an in focus and complete graphic.



Text Styles
PRODIGY's Web browser automatically uses the Times New Roman font family as a default text scheme. 
While you cannot make changes to the scheme designated Web Browser Default, you can create 
additional schemes to suit your tastes. Additionally, you can globally change the color of the font in any of 
the new Text Schemes you create.

To specify your own Text Scheme, select the Font/Color button next to the displayed font sample.

The standard Windows Font Select dialog window will display and you can easily select any font from the 
Font drop down list box, specify regular, bold, italic, bold italic (etc.), and point size. The available options 
will vary depending on the font selected. If you wish to select a specific color, use the Color drop down list 
box .

Next, select OK to return to the Text Styles window. To preview your new text scheme, you can view what 
each element in a HTML document might look like (Normal Text, Headings, etc.) by selecting an Element 
from the Element drop down list box in the center of the window. The Sample display changes 
dynamically according to the element selected. Select Save Scheme and supply a name for it and then 
select OK. You can return to this window at any time to select any Scheme you have previously saved, 
remove a saved scheme, edit a saved scheme, or return to the PRODIGY Web Browser Default scheme.



Get URL
When Get URL is selected from the Navigate menu, the Get URL dialog window is automatically 
displayed. Type (or paste) a URL into the edit field and then select OK. Select Cancel to return to the Web 
page you were previously reading.



Hot List Dialog Box 
From the Hot List dialog box, you can navigate to any page previously saved on any hot list, re-arrange 
the order of entries, edit hotlists as well as create and delete entire hotlists. To Create a Hot List, select 
the Create List button. To Delete a Hot List, make sure the list you wish to delete is displayed as the 
current Hot List and then select Delete List. If you have created multiple Hot Lists, use the Select List 
drop down list box to change lists while using the Web browser.

Go 

If you highlight an entry in the hot list box and click here, you will go to that page 

Close 

This will close the hot list dialog box 

Move Up 

If you highlight an entry in the hot list box and click here, it will be moved up one place.    This is used to 
re-order entries in your hot list. 

Move Down 

If you highlight an entry in the hot list box and click here, it will be moved down one place.    This is used 
to re-order entries in your hot list. 

Remove

Deletes (removes) the entry that is currently highlighted from the current Hot List

Edit

Edit the description or URL for the currently highlighted entry

Add to Hot List 

Add current Web page to your Hot List.



Page Setup
Since the printable area varies greatly between printers, the PRODIGY Web browser allows you to 
customize the top, bottom, left and right margins. Figures shown are in inches. The default is .50 (one-
half) inch margins for all four sides. You should experiment to find the margin settings that works best with 
your printer.

To toggle printing the PRODIGY footer on an off, click in the Print Footer checkbox.



Global History
You may keep an optional Global History of your 'travels' through the Web. To enable Global History, click 
in the Enable Global History checkbox. All URL's visited after enabling global history will be listed. The 
display will include the date and time you accessed the URL and the full URL specification. To re-visit any 
URL, highlight it to select it and then select GO. To cancel and return to the browser, select close. To 
completely clear the list of entries, select Clear List.

Note that you cannot edit the Global History list but only clear it completely.

Important: If the browser displays an error message "there are too many items to display..." you 
should select Clear List to delete all entries and start over.



Advanced Setup Options
These choices appear on the Advanced Options menu: 

Viewer Setup 

Provides an easy way to add external viewer support for audio, image and motion picture files you may 
encounter on the Web. (Support for basic audio (*.au and *.wav) and GIF and JPEG images (*.gif and 
*.jpg) is already included with the PRODIGY Web Browser.) 

Stage Setup 

For quicker access to documents and images on the World-Wide Web, the PRODIGY Web Browser uses 
a special file called a stage.    The stage makes Web Browser faster by storing Web items you've already 
retrieved, so that they can be re-accessed almost instantly. 

As you use the Web Browser, most of the documents and images you download are automatically saved 
to a special file on your hard disk (in your PRODIGY software directory).    When you call for the same 
documents and images in your next Web Browser session, the software first checks to see if they're 
stored in the stage, instead of downloading them again.    Only if the item is something new to you will the 
Web Browser begin downloading it through your modem. 

Many documents and images on the Web change from time to time.    The Web Browser uses a technique 
called version checking to ensure that the items stored in the stage are up to date. 

All items in the Web Browser stage carry a tag indicating the date and time they were last changed. 
Periodically, the Web Browser does a version check by comparing the date of the stored item with the 
date of the item on the Web.    If the dates are different, it means the item has changed, and the Web 
Browser begins downloading the new one. 

Document Setup

The PRODIGY Web browser will automatically display a prompt giving you the opportunity to save a large 
page to disk if the page retrieved is over the default setting of 150KB. Advanced users may want to alter 
this setting from time to time (or even "on the fly") for optimum performance.

The PRODIGY Web browser will automatically display a prompt giving you the opportunity to save a large 
page to disk if the page retrieved is over the default setting of 150KB. Advanced users may want to alter 
this setting from time to time (or even "on the fly") for optimum performance.

 Click for more info on Document Setup

See Also:
Viewer Setup

Stage Setup



Viewer Setup
To see and hear images and sound provided in other formats, you'll need to obtain and install accessory 
programs called viewers . A variety of viewers have been created to decode the different kinds of files 
you may encounter as you browse the Web. As experienced Web surfers have found, these external 
viewers make Web browsing richer and more entertaining.

To add a new viewer, first select Add Type. Next, specify the Type. (Hint, if you attempt to FTP or 
download a file and the browser displays a message such as "there is no viewer available for 
video/mpeg" you'll know that the type of viewer needed is video/mpeg). After specifying the viewer type, 
you need to specify the location of the program. To do this, select the Browse button which displays a 
standard Windows file select dialog box. Navigate to the directory where the executable can be found, 
highlight it and then select OK. When the viewer you have selected is displayed in the Viewer field, select 
OK to return to the Web browser. If you wish to return to the Web without adding a viewer or don't wish to 
add the viewer you've just specified, select Cancel.

Extensive information on viewers is available from the PRODIGY home page where you can select 
[Viewers] for comprehensive information.

For assistance with external viewers, you can visit PRODIGY's Internet Forum Bulletin Board. Jump: 
internet bb and select the Wide World Web topic. The many knowledgeable Web users who frequent 
the board are usually happy to answer questions about external viewers and where to find them. But be 
sure to browse the board before posting. You may find that your question has already been answered!



Stage Setup

Normally, the Web Browser will version-check an item the first time you need it in your session.    
However, if you use the Web Browser frequently, you can make it run faster by setting it so it does version 
checks less often.    In the Stage Setup dialog window, mark Estimated Expiration to toggle from the 
default Each Session setting.
The frequency of version checking can be fine tuned from the refresh interval settings.    Normally, the 
refresh interval is set to 0, which means items are checked once each session.    If the refresh interval is 
set to 12, for example, items will be checked only if they haven't been checked in the last 12 hours.    As 
you increase this setting, you will see the Web Browser run faster, but at the risk of seeing pages that are 
out of date. To change the Refresh Interval, replace the number of hours shown with a higher or lower 
figure.

If you think a document has changed recently, the first thing to check is the document date.    From the 
Help menu, select Document Header. This shows the date the document was delivered to PRODIGY, and 
(usually) the date the document last changed.    If you still suspect the document is out of date, you can 
download the latest version available at PRODIGY by pressing the Reload button.    Reload will download 
a fresh copy of the document and any images it carries.    You can also try the command Reload From 
Host (in the Navigate menu).    This does the same thing as Reload, except that it bypasses all levels of 
caching and gets a new copy of the item directly from the provider.    However, Reload From Host will 
usually take longer than Reload. 

Most documents include a header, a hidden piece of the document that contains information such as its 
type and length.    You can view the header of the document currently displayed by selecting Document 
Header... from the Help menu.    In the header, you will usually see a line that says "Last-modified:", 
indicating the time and date the document was created or most recently changed. This time is given in 
GMT (Greenwich Mean Time), which is 5 hours later than Eastern Standard Time, and 8 hours later than 
Pacific Standard Time. 

There are two limits to the size of the stage file.    One is a limit on the number of items in the stage, 
normally 1,000.    Another is a limit on how much of your disk space the stage will take. When either of 
these limits is reached, Web Browser will forfeit (remove) an item each time one is added. 

The Web Browser keeps track of the date and time each item in the stage is accessed.    If it needs to 
remove an item, it forfeits the one least recently used. 

Not every item is considered "stageable".    The Web Browser will not store any document that was the 
result of a search or a fill-out-form, because these documents tend to change frequently and aren't likely 
to be needed again.    Also, there's a limit to how large an item can be -- normally, the Web Browser won't 
store any item larger than 50,000 bytes in the stage. 



Authorization Dialog Boxes
As you travel the Web, you're bound to encounter sites which require special enrollment and require 
authorization for access each time you visit that particular site. 

PRODIGY Services Co. is not involved in authorization control for these sites. The request for a User 
Name and Password is generated by the site you are accessing and the Web browser displays a 
convenient dialog box where you can enter this information. 

Do not use your PRODIGY ID as a user name or your PRODIGY Password if you request access to 
these special sites from the provider and do not ever enter this information in this type of dialog 
box as it is transmitted 'in the clear' over the internet.



Document Size Settings Dialog
The PRODIGY Web browser will automatically display a prompt giving you the opportunity to save a large 
page to disk if the page retrieved is over the default setting of 150KB. Advanced users may want to alter 
this setting from time to time (or even "on the fly") for optimum performance.

To change the default setting, replace the 150 default setting with a different number. Typically, text only 
documents up to around 150KB (150,000 bytes approx.) display properly while online. Huge documents 
(some on the Web are over 1 meg) cannot be displayed by the browser and must be saved to disk for 
later viewing. 

As an example, a text file called INDEX.TXT is always available at the Microsoft FTP site 
(ftp://ftp.microsoft.com/Softlib/INDEX.TXT). If the file is under 150,000 bytes, it will display properly on 
screen (and you can save it from the File menu as well). If you change to setting to 80 (typically this file is 
at least 95K in size), when the page has completed downloading the save to disk prompt dialog will 
display automatically.

Select Yes to save to a file on your hard drive. If you select No, the browser will attempt to display the 
page.

There are many locations on the Web that download extremely large files, such as 
ftp://town.hall.org/Archives/edgar/data/34945/0000950112-94-002774.txt which is well over 1 meg in size. 
You will see the file size/page size on the status bar as the download proceeds. For large files of this 
magnitude, selecting Yes is the proper option.

You can change this setting to load large files to disk at any time while on the Web or even before you go 
online if you run pweb.exe as a standalone program. 



Where to go for more help
For more information on the World Wide Web and Internet 

<Jump> Internet BB 

and see the World Wide Web bulletin board topic. 

For additional help and information 

<Jump> Member Help BB 

and see the World Wide Web bulletin board topic. 

More information is available from Quick Help on the Prodigy Home Page. 

For the most up to date information and to learn about the most recent developments and features 
of the current version of the Web browser, from the PRODIGY home page, select [Browser News] .




